
    

 

     

Documentation Prepared By STA 
June 2009 1 



    

 

     

Documentation Prepared By STA 
June 2009 2 

Design Tools -  Frame View 

 
 General 
   Select 
   Pan 
   Zoom Reset 
   Zoom In 
   Zoom Into 
   Calliper 
   Rotate 
   Delete 
   Zoom Out 
   Zoom Out of 

 
Icon  Description 

Select 

 
 

Clicking Select allows you to select an object on the Drawing Board. 
Objects turn red when they are selected. To select more than one object, 
press the shift key while you select each object. 
 

Pan 

 
 

Click Pan, and then drag an item across the drawing board to pan from 
side to side. 

Zoom Reset 

 
 

Returns you to the view you previously had when the drawing board was 
first opened. 

Zoom In 

  
  

This enlarges the visual display of the selected item. 

Zoom Into 

 
 

Zooms into the currently selected Lite, Face, and Point. 

Calliper 

  
  

The callipers cursor is positioned on the drawing board where you want the 
X and Y axis to be situated. The cursor’s distance from the x-axis, distance 
from the y-axis and distance from the axis point (i.e. 0, 0) is shown at the 
bottom of the dialog box. On the frame drawing board, the callipers allow 
you to define and measure distances between objects. 

 
Rotate 

  
 

Rotates the frame to the orientation you want. 

Delete 

  
 

Deletes the item you have selected on the drawing board. 

Zoom Out 

  
 

This reduces the visual display of the selected item. 

 
Zoom Out of 
 

 
Zooms out of the current view. 

   

Disable Mouse 
Dragging 
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Design Tools -  Face View      
 
  
 
 

 Section 1 - Wireframe Tab     4 
   Merge Lite 
   Lock / Unlock Points 
    

 Section 2 - Resources Tab     6 
   Nested Frames 
   Assembly Substitution 
   Reverse Assembly 
   Merge Assemblies 

  Lites Equal on Height 
   Add Frame View 
 

 Section 3 -    Joints Tab      12 
  
 

 Section 4 - Tools Tab      14 
   Thumbnail 
   Refresh 

     
 Section 5 -    Wizards Tab      16 
   Options Wizard 
   Assembly Wizard 
   Grid Frame Wizard   
   Stepped Frame Wizard 
   Split Lite Wizard 

  Horizontal Dimension Wizard 
  Vertical Dimension Wizard 
   
 

Section 6 -    Macro Tab      28 
 Can consist of some or all of these depending on the  framing system. 

  Grid Frame Macro 
  Door Macro 
  Fixed Lite Macro   
  Awning Window Macro 
  Raked Frame Macro 
  Angle Trim Macro 
  Lit by Lite Glazing Macro 
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Design Tools – Face View 
 

Section 1 - Wireframe Tab 

 

 

Merge Lite  
 

 

 
 

 
If you require to Merge Lites this can be achieved by the following steps - 
 

 Select the Lites that you want to merge by either selecting them on the drawing board or 
under the Objects Tree. (Remembering that if you want to select more than one lite to hold 
the Shift Key on your Keyboard). 

 Click on the Wireframe Tab and click on the merge lites button  . 
 This will display the following box asking you which lite you would like to keep. 

 

 

 

 Once you have selected the Lite you would like to keep then click on the  
button. This will then merge the Lites. 
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Lock and Unlock Points 
 

 
 
 
When you are creating a Frame by default the Points are Unlocked. When you lock Points and 
Lines these will move as one. 
 

 Drag your mouse over the Lines and Points that you want to lock so these are 
highlighted red. (See the following picture). 

 Then click on the  button to Lock the points. Or to Unlock the points click on the 

 button. 
 

 
 

 You will notice that we have used the Locked Points to Move a Line which will 
become our Transom in this Frame. Therefore the two lines will move together. 
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Section 2 - Resources Tab 
 
 

Nested Frame  
 

 

 

To Nest a frame use following steps - 
 

 Select the Lite so it is highlighted red. Click on the Resources Tab and click on the following 

icon . 
 This will display a Frame Picker Browser, from here you can select the frame to nest. 

 

 
 

 Select from the list then click on the  button. 
 

 This will then display a “Place ……………. in Receptor?” box, like the following. 
 

 

 

 Select the appropriate receptor and click OK to populate the frame 
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Assembly Substitution 
 

 
 
 
If you require a different Assembly to the one that you first selected you are able to use the 
Substitution icon. 
 

 Select the Assembly which you want to Substitute, by selecting it in the Objects 
Tree. 

 Click on the Resources Tab and click on the  button. 
 This will bring up an Assembly Picker Box, select the Assembly you require and click 

on the  button. 
 This will then Substitute the Assembly for the one that you have selected. 

 
 

 

 

 

 

Note: If the Assembly that you have selected does not substitute make sure to check that 
your joints have remained. 
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Reverse Assembly 
 

 

 

 

Once you have placed an Assembly onto your frame and if you notice that the Extrusion you 
require is on the wrong side you can select Reverse Assembly. This will reverse the Assembly. 

 
 Select the Assembly that you want to Reverse, by selecting it in the Objects Tree. 

 Click on the resources tab then click on the following icon , this will reverse the 
Assembly. 

 
 

 

Note: This should not need to be used as the database has been designed to orientate 
the assemblies the correct way around. 
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Lites Equal on Width 
 

 
 
 
If you require to make the Lites Equal on Width this is achieved by the following – 
 

 Select the Lites that you want to make equal, by clicking and selecting them on your 
drawing board, remembering to hold the Shift Key on your keyboard to select more 
than one. 

 Click on the Resources Tab and then click on the  button. 
 This will then display the following box, asking you to select which Receptor to use. 

 

  

 

 Select the Receptor and press the OK Button.  
 

 

Note: To achieve equal Glass and Equal Heads and Sills use the Glass or Daylight Receptor. 
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Lites Equal on Height 
 

 
 
 

If you require to make the Lites Equal on Height this is achieved by the following – 
 

 Select the Lites that you want to make equal, by clicking and selecting them on your 
drawing board, remembering to hold the Shift Key on your keyboard to select more 
than one. 

 Click on the Resources Tab and then click on the  button. 
 This will then display the following box, asking you to select which Receptor to use. 

 

  

 

 Select the Receptor and press the OK Button.  
 

 

Note: To achieve equal Glass use the Glass or Daylight Receptor. 
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Add Frame View 
 

 
 

Frame View is denoted by a graphic of a video camera .   
You must be in Frame View to use this function. 
 
Frame View allows the estimator to capture of snap-shot of the frame at any angle or view they 

wish. Simply generate the view or rotation you wish and press the  button. This Frame 
view taken is added to the Objects tree from where it can be viewed at any time.  
 
To view a previously saved Frame View –  
1.  Select the View from the Object tree    2) Right-click and select EDIT   
 

 

 

 

Frame View snap-shots are also available for use within the Presentation tab. 
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Section 3 - Joints Tab 

 

 

 

 

This function is generally taken care of automatically when the grid frame wizard is run but can 
be useful if a joint is not correct. 
Instructions below explain how to correct a cut. 
 

 Click on the Joints tab. 
 Make sure you have your Points Displayed on the Drawing Board. Right Click and go 

to Display. Make sure the Point has a check next to it. 
 Select one of the Points on the outer Frame. This can be done by either clicking on 

the point on the Drawing Board or selecting it in the Objects tree on the left hand 
side. 

 Click on the  button and this will zoom into the point you have selected. This will 
then look like the following. 

 

 

 

 

 

 

 

 

 

 

 

 You now need to select the Extrusion and the Buttline you would like to join. This is 
done by holding the Shift Key on your Keyboard and selecting the two from the 
Objects Tree on the Left hand side. See the following picture. 
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Note: All the Butt Lines are in Upper Case and all the Extrusion names are in Proper Case. 

 
 

 The drawing board will then look like the following. 
 

 

 

 You will notice that our Head Extrusion has been selected and our HEAD/SILL 
buttline has been selected. We can now join the two. 

 Click on the  button and this will join the two. Your Drawing Board should now 
look like the following. 

 

 

 

 You will notice that the two have joined. You will need to repeat these steps for all of 
the Points that you would like to join.
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Section 4 - Tools Tab 

 

Thumbnail 
 

 

 

 

When you create a Frame in the Design View you are able to take a Thumbnail. This is a picture of your 
frame that you have created. This picture will then be placed on your reports. The Thumbnail can be 
taken either when you are Zoomed Into the Frame or Zoomed out of the Frame. 
 
You may want certain things not to be displayed when you take a Thumbnail such as the Points for a 
neater appearing picture. To do this Right Click on the Drawing Board and click on Display. The 
following menu appears. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
From this menu you can select or de-select what you require or don’t require. 
 

Click on the Tools tab and then click on the  button. You will notice that a Thumbnail now appears 
on the bottom Left Hand corner of the quote of that particular item. 
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Refresh 
 

 

 

 

 

To Refresh the view within the Design Tab click on the Tools tab and click on the , this will refresh 
the view.
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Section 5 - Wizards Tab 

 

Options Wizard 
 

 
 
Here you are able to select Finishes, Glass and change Frame Options. 

 Click on the Wizards Tab then click on the  button. This will display the following 
screen. 

 

 

From within this screen you are also able to change frame options. 
 

 Click on the Frame Attributes Tab. Here it lists all the available options for that frame. 
 Clicking next to a frame option will bring down a drop down menu allowing you to 

select from the choices listed. This can also be done from within Options/Edit Options 
Tab. 

 

 

Take care not to 
check/uncheck these boxes 

 

 

  

 

 

 

 

       

   

  

A tick in this box will show 
only the options you can 
select 
 



    

 

     

Documentation Prepared By STA 
June 2009 17

Grid Frame Wizard            
 

 

 

 

Each Frame Group within the LIDCO database has a DESIGN frame. 
 
IT IS STRONGLY ADVISED that you use this DESIGN frame whenever a special shape/style 
is required. 

 
Once you have added your Design Frame (by adding a standard existing frame) to the Quote it is now 
time to create the frame using the Grid Frame Wizard. The Grid Frame Wizard allows you to create a 
complete frame. 
 

 Click on the Design Tab from within the Quote - Select the Wizards Tab and Click on the 

following icon , this will then display the following screen. 
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Enter the Frame Height & Width 
 
Enter in the Height and Width of the frame. (Millimetres) 

 
Layout 
 
Enter in the Number of Rows (i.e. Horizontals) and/or enter in the Number of Columns (i.e. Verticals). 

 
Lite Code 
 
If the number of rows is to be different for each column, enter a lite code in this field. Entering a lite code 
(instead of columns and rows) can create frames that have a different number of lites in each column. 
Eg. A lite Code of 213 will draw the following Wire Frame. i.e. 2 Lites, 1 Lite, 3 Lites. 
 

 

 

Create Frame with Equal Lites 
 
Check this box to create equal lites.  
 

 Clicking on the Custom button will present the following screen. 
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Assemblies Tab 
 
This tab allows you to select the Assemblies that are going to be placed onto your Wireframe. These will 

be set to defaults but you are able to select others by clicking on the  Button will bring up an 
Assembly Browser.  
 

Select from the list then click the  button. Repeat this step until you have placed 
Assemblies on all of the Lines. 
 

Note: For internal lines such as Transom and Mullions if you have selected more than 
one, these can be selected here and then Substituted at a later stage. Please see steps 
that follow. 

 

 
 

 
Glass Tab 
 
This tab allows you to select the Glass that you require for the Frame. This can also be done 
on the Items/Options Tab, Edit Options. 
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Joints Tab 
 
This tab allows you to set the joints for the Outer Framing. The default joints are the following. 
 

 
 
Hover your mouse on the joint you wish to change and a menu will appear. You can select a 
new joint from this menu. 

 

 

Click on the  button once you have finished this will then populate your Wireframe. 
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Your drawing board should now look like the following-   
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Stepped Frame Wizard 
 

 

 

 

To create a frame with a stepped sill in V6, you must first create a rectangular frame with all assemblies 
and fills, and then remove a portion of the frame. The Stepped Frame Wizard performs the removal. 
 
The Wizard will need a Head or Sill Assembly to be selected in order to complete the operation. It will 
remove all the Assemblies on the Head, Sill, left and right Jamb surrounding the Lite, and split any up if 
necessary. The first internal horizontal assembly found will be substituted for the new head or sill 
assembly. 
 
A step will be created where at least two lites exist, one of top of the other. In the case where only one 
lite exists the entire lite including head/sill and fill will be removed. 
 
V6 will automatically shorten vertical Assemblies – such as Jambs and Mullions, and will remove Lites 
and Fills, and place sill assemblies along the new edge and reconstruct all joints during the process. 
 

 To Step a Frame, Click on the lite so it is highlighted Red 
 

 

 

 Click on the Wizards Tab and click on the  button. 
This will display the following box – 
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 Click OK. 
 

 Your drawing board will then look like the following – 
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Split Lite Wizard 
 

 

 

 

If you require to Split the Lites this is achieved by the following steps – 
 

 Select the Lite or Lites that you want to Split. 

 Click on the Wizards Tab and click on the  button. 
 

 This will then display the following box. 
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 Enter in a Lite Code. 
 

eg. Entering in a 2 will display the following within a lite - 

 

 
 
Entering in 11 will display the following within a lite - 
 

 
 
 

 Select the Assemblies that you want to place on the Horizontal and the Vertical. (These will 
be set to the default but can be changed here). 

 Select the Joints (this will be set to the default). 
 

Note: Using the Split Lite Wizard on this Tab instead of the Split Lite Wizard on the Wireframe tab will 
set the Joints for you providing these have been selected. 

 

If there is glass in the lite to be split, the correct receptor needs to be chosen. 
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Horizontal Dimension Wizard 
 

 

 
This Wizard allows you to set up a dimension for a Lite. This can be done by the following steps – 

 
 Select the Lite that you want to place a dimension on. 

 Click on the Wizards Tab and click on the  button. This will then display the following 
screen. 

 

 

 Enter in the Width that you want to set the Dimension to. (Millimetres). 
 

 Select the Line that you would like to move, either Left or Right. 
 

 Type in a Name for the Dimension. 
 

 Select the Left and Right Reference Objects. This will be Day Lite. 
 

 Select whether or not you would like to place a Constraint on the Dimension. Entering in 
Minimum & Maximum Values. This will then stop the user from going below or above these 
values. 

 Or you are able to specify a Formula. 
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Vertical Dimension Wizard 
 

 

 
This Wizard allows you to set up a dimension for a Lite. This can be done by the following steps – 
 

 Select the Lite that you want to place a dimension on. 

 Click on the Wizards Tab and click on the  button. This will then display the following 
screen. 

 

 

 

 Enter in the Height that you want to set the Dimension to. (Millimetres). 
 Select the Line that you would like to move, either Top or Bottom. 
 Type in a Name for the Dimension. 
 Select the Top and Bottom Reference Objects. This will be Day Light. 
 Select whether or not you would like to place a Constraint on the Dimension. Entering in 

Minimum & Maximum Values. This will then stop the user from going below or above these 
values. 

 Or you are able to specify a Formula. 

 

Note: When creating Dimensions it is important not to move your frame from the origin (i.e. the 
dotted line on your drawing board). Make sure you select the correct line to move so that you 
frame does not move off this origin point. 
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Section 6 - Macro Tab 
 

Grid Frame MACRO 
 

 
 
The Grid Frame Macro provides the same functions as the Grid Frame Wizard that we looked at earlier 
on the Wizards tab. 

 
Door MACRO 
 
 
LIDCO have created a series of Door Macros within their relevant frames to automate this process and 
ensure no steps are ‘missed’ by operators. 
 
These can be accessed via the Macro Tab –  
 

There is a choice of Hinged and Sliding doors in either Pocket Glazed or Bead Glazed 
options. 
 

 

 

 

Instructions for use of these Macros is explained in the Design Trainer Manual – Pages 11 & 12 
 
 
Fixed Lite MACRO 
 

 
 
This Macro places a fixed lite in any selected frame.  
Eg: You can use this macro to change a door back to a fixed lite in 1 easy step. 
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Awning Window MACRO 
 

 

 

Insert an Awning Window into your frame by following these steps- 
 

 Select the lite that you want to use by clicking it so it turns Red 
 

 Click on the Awning Window Macro icon 
 

 Select your window options  
 

 
 

 Click OK one you have finished to place the awning window into the frame  
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Raked Frame MACRO 
 

 
 
 

This Macro is designed to lead the estimator through the necessary steps to rake a frame on 
the Drawing Board. 

 

 

 

 

 

 

 

 

   

The result- 
 

 
 
 
 

 

 

 

 

 

 

 

 Select which end of the Frame you want to move either Top or Bottom. 
 Change either the Value of the Left Jamb or the Right Jamb. 
 
 E.g. Enter Move Top and Right Jamb 800 as in the above example 
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Angle Trim MACRO 
 

 

 

This Macro is designed to attach angle trim to various parts of the frame in 1 easy step. 
 

 

 

 

 

 

Lite by Lite Glazing MACRO 
 

 

 

When selected, this Macro will display the current frame with BLUE edges around each lite 
containing glass. The glass selected within each lite at this stage will depend on the selection 
made in DEFAULTS. 
 

 

 

 Select the placement & 
type of anlge trim required 
from the drop-down 
menus. 

 
 Enter the offset 

 
 Click OK to populate the  
frame 
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To change a glass selection, simply click on the lite (or multiple lites by holding down the 
SHIFT key) to be changed and select the Glass icon 
 

 

 

 

This will take you to the Glass browser where you can select the appropriate glass type. 
 

 

 

 

Once you have selected your glass, click OK.  
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Sliding Window Macro 
 

 
 

 Select the lite to insert the window into by clicking it so it turns Red. 
 

 
 

 Click on the Sliding Window Macro icon 
 

 Select Track, Configuration & Latch options, then click OK to populate the frame. 
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Double Hung Window Macro 
 

 
 

 Select the lite to insert the window into by clicking it so it turns Red. 
 

 
 

 Click on the Double-hung Window Macro icon 
 

 Select Flyscreen option & click OK to populate the frame 
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Sub Head / Sub Sill Macro 
 

 
 

 Select the lite to insert the sub head or sill into by clicking it so it turns Red. 
 

 
 

 Click on the Sub Head/Sill Macro icon 
 

 Select placement options & click OK to populate the frame 
 

 
 


